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Introduction 
This white paper explains how to install and use the IBM® Workload Simulator Adapters for 
Rational® TestManager, Version 1, Release 1.0.1 (WSim Adapters). The paper is intended 
primarily for software testers familiar with either IBM Workload Simulator (WSim), Rational 
TestManager, or both products.  

The WSim Adapters extend Rational TestManager for Windows 2000 and Windows XP. There 
are two sets of WSim Adapters in all, one for running Workload Simulator Test Manager (WSim 
TM) schedules and one for running custom JCL scripts. The WSim Adapters enable software 
testers to use Rational TestManager to run WSim TM schedules and custom JCL scripts 
remotely and in batch mode.  

If you are not familiar with Workload Simulator for z/OS® and OS/390® or Rational 
TestManager, here are brief descriptions of those products: 

Workload Simulator for z/OS and OS/390 is a z/OS-based, terminal and network simulation 
tool. WSim TM is a z/OS-based usability enhancement to Workload Simulator that guides the 
user through the test process. WSim TM creates projects that contain schedules for simulation 
runs.  

For more about WSim and WSim TM, see the Workload Simulator for z/OS and OS/390 web 
site. 

Rational TestManager is a Windows® console for test activity management, execution, and 
reporting. This tool is an open and extensible framework that unites all of the tools, assets, and 
data related to the testing effort. It is available stand-alone or as part of the following Rational 
products: 

• IBM Rational Functional Tester for Java and Web 
• IBM Rational Robot 
• IBM Rational Performance Tester 
• IBM Rational Team Unifying Platform 

For more information about Rational TestManager, see the Rational TestManager web site. 

The remainder of this paper explains how to install, register, and use the WSim Adapters with 
Rational TestManager. 

Preinstall information 

Before you can use the WSim Adapters, your Workload Simulator administrator must have 
already installed and run the PTF that fixes APAR PQ94132 on you z/OS or OS/390 system. 
The install executable for the WSim Adapters is included in this PTF. Contact your Workload 
Simulator administrator to download this executable. 
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Related documents 

• Documents for IBM Workload Simulator for z/OS and OS/390 
• Rational TestManager Help (available from the Rational TestManager Help menu) 

Software prerequisites 

• IBM Rational TestManager V2003.06.00 or higher for Windows 2000 or Windows XP 
• IBM Workload Simulator Version 1 Release 1.0.1  
• Windows 2000 (Service Pack 4) or Windows XP (Service Pack 1 or earlier) 
• Microsoft Internet Explorer 5 or higher 
• z/OS 1.4 or higher 

Installation  
The WSim Adapters install program installs two sets of dynamic link libraries. One set runs the 
WSim TM schedules; the other runs custom JCL scripts.  

Installing the WSim Adapters 

1. Run WSimAdaptersRTMinstall.exe.  
2. Accept the license agreement. 

The WSim Adapters for running WSim TM schedules and custom JCL scripts are installed in 
the Rational Test directory. The default is the Program Files\Rational\Rational Test\ directory. 
The WSim Adapters directory is created under the Rational Test directory. 

The skeleton JCL file, backup skeleton JCL file, and this white paper are also installed.  

Note that if you are accessing this paper from a web site, there’s no need to check the box for 
displaying this white paper. 

Uninstalling the WSim Adapters 

To uninstall the WSim Adapters, you can run the same executable used for installation. 
Alternatively, you can use the Windows Add/Remove Programs feature in the Windows Control 
panel.  

If you are planning to uninstall the WSim Adapters and did not use the WSim Registration tool 
to register them, you will need to delete the WSim Adapter script types from your registry. You 
will also need to delete any test cases that used the WSim Adapters. 

Working with Workload Simulator Test Manager schedules 
After installing the WSim Adapters for running WSim TM schedules, you need to register them 
as a new test script type. You can then use them to retrieve and display WSim TM projects and 
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schedules in Rational TestManager, run the schedules, and see the pass/fail results and job 
output of the run. 

Remember that to run WSim TM schedules from Rational TestManager, the schedules must 
already exist in WSim TM on the host system. In addition, you need the following IDs and 
passwords to run WSim TM schedules: 

• TSO FTP User Name and password  
• TSO WSim User Name. This is the TSO user name that created the projects and 

schedules through WSim TM. This can be the same ID as the TSO FTP User Name.  

Registering the WSim Adapters for running WSim TM schedules 

The first step is to register the WSim Adapters for running WSim TM schedules. This 
registration is needed for each Rational TestManager project used to run WSim TM schedules. 
You must have administrator privileges to register the WSim Adapters.  

You can register the WSim Adapters two ways: automatically, by using the WSim Registration 
Tool, or manually.  

Automatic registration 

1. From the WSim web site, run the WSim registration tool installation program 
(WSimAdaptersRTMRegInstall.exe).  

This places the registration tool, WSimAdaptersRTMRegistrationTool.exe, into the 
WSim Adapters directory in the <Rational TestManager install path >.  

2. Register the WSim Adapters by running the WSimAdaptersRTMRegistrationTool.exe 
program. 

3. Enter a Rational TestManager user name and, if required, its password. 
4. Select the projects in which you want to run WSim Test Manager schedules. 

Manual registration 

1. Log in to Rational TestManager by project. 
2. Click Tools->Manage->Test Script Types. 
3. In the Manage Test Script Types window, click the New button. 
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4. On the General tab of the New Test Script Type window, name the test script type you 
are creating. For example, you could name this test script type something descriptive 
such as “WSim TM schedules”. 

 

5. On the Console Adapter Type tab, click Use a custom console adapter and enter 
the path to the installed adapter libraries: <Rational TestManager install path>\WSim 
Adapters\ITMWTMCA.dll. 

 

6. On the Execution Adapter Type tab, click Use a custom execution adapter, and 
enter the name of the execution adapter: ITMWTMEA. 
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7. Click OK. 

The new test script type is displayed in the Manage Test Script Types window. 

 

8. In the Manage Test Script Types window, click Close.  

This completes the procedure for registering the WSim Adapters for running WSim TM 
schedules. 

Creating a new test script source 

The next step is to create a local test script source for the schedules. This local source 
corresponds to the schedules located on the host system. Think of the local source as 
corresponding to a host account. 

1. Click View->Test Scripts. 
2. In the Test Scripts window, right-click the test script type you created when registering 

the adapter (in the example, “WSim TM schedules”) and click New Source. 
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3. On the General tab of the New Test Script Source window, name the source in the 
Name field. (for example, user7@zos108). 

 

4. Click the Connection Data tab.  
5. In the Data path field of the Connection Data tab, use the Browse button to specify a 

path to a unique, local directory for the source. If the directory does not exist, you can 
type a source directory name and a directory will be created for you.  

This directory must be a unique, local directory that is not used for anything else other 
than a single source. If the directory is used for anything besides a single source, run 
time errors can occur.  

It is recommended that the directory share the name of the TSO user under which the 
WSim TM projects and schedules were created, along with the host name. For 
example, for the test script source user7@zos108, consider creating the directory 
<Rational TestManager install path>\user7@zos108. 

Note that multiple users on the same machine should have their own test source 
directories.  
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6. Click OK. 
7. Optional: To create paths to other test script sources, repeat this procedure. Remember 

that each test script source MUST have its own unique directory. 

This completes the procedure for creating a new test script source for running WSim TM 
schedules. 

Retrieving WSim TM projects and schedules 

The next step is to retrieve WSim TM projects and schedules defined for the user ID specified 
in the test script source login information. The WSim Adapters retrieve all project names 
assigned to a WSim user ID and all schedule names for each of those projects.  

The WSim Adapters retrieve the WSim TM schedules under each project. The WSim TM 
project and schedule names and associated information needed to run the schedules are also 
retrieved.  

Note that you cannot view or edit the content of WSim TM schedules in Rational TestManager. 
You can view and edit schedules only on the host system.  

1. If the Test Scripts window is not displayed, click View->Test Scripts.  
2. In the Test Scripts window, expand the test script type you created (in the example, 

“WSim TM schedules”) by clicking the + symbol next to the type. 

The test script source you created is displayed (in the example, “user7@zos108”).  
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3. Expand the test script source by clicking the + symbol next to the source.  

If you are running a schedule for the first time, the Login Information window is 
displayed.  

If you are not running a schedule for the first time but need to edit login information, 
right-click the source and select Edit Login Information. The Login Information 
window is displayed. 

 

4. In the Hostname field of the Login Information window, enter the name or IP address 
of the host where the WSim TM schedules are located. 

5. In the TSO FTP User Name and Password fields, enter your host FTP user name and 
password.  

6. Do one of the following: 

• To log in to TSO with the same user name and password used for FTP, ensure that 
the Same as TSO FTP User Name box is checked. This is the default. 
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• To log in to TSO under a different user name from the one used for FTP, ensure 
that the Same as TSO FTP User Name box is unchecked, and then in the TSO 
WSim User Name field, enter the TSO user name where the WSim TM projects 
and schedules were created. 

7. In the Job Name Suffix Character box, select a different suffix if needed. Otherwise, 
leave the default at “R”.  

Note: The WSim schedules associated with a TSO ID do not run in parallel unless they 
have been specifically designed to do so. This is because the schedules use VTAM 
APPL resources for terminal simulation, and most schedules reference the same VTAM 
APPL resources. To avoid problems, set a unique job name suffix character and FTP 
ID for each WSim TSO ID used to run a specific schedule. This forces duplicate job 
names, which forces the schedules to run serially. 

8. Do one of the following: 

• To display job status while the job is running and to have Rational TestManager 
wait for the job to finish, check the Monitor job execution with Rational 
TestManager box. You can set an execution timeout value in the Job Execution 
Timeout fields. This timeout value specifies how long to monitor the job before it 
ends. The default is no timeout.  

Note: If you specify a job timeout value and the job is cancelled, no host job output 
will be available for viewing. 

• To not have Rational TestManager monitor job status, leave the Monitor job 
execution with Rational TestManager box unchecked. The job will continue to run 
without monitoring.  

9. Test your connection to the host to see if there are any login errors by clicking the 
Attempt to login to host button . If you receive an error, correct any fields related to 
the login error.  

10. Click OK to retrieve WSim TM projects and schedules from the host.  

This completes the procedure for retrieving and displaying WSim TM projects and schedules. 

Running a WSim TM schedule and viewing its output 

The next step is to run a schedule and view its output. 

1. In the Test Scripts window, expand a project under the test script source to see the list 
of schedules. 
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2. Right-click a schedule and click Run from the pop-up menu. 

 

The Run Test Script window is displayed. 

3. In the Run Test Script window, click OK to run the schedule. 

If you checked the Monitor job execution with Rational TestManager box in the 
Login Information window, the job is monitored, the Test Log window is displayed 
when the job completes, and the host job output is retrieved.  

If you did not check the Monitor job execution with Rational TestManager box in the 
Login Information window, the Test Log window is displayed when the job completes. 
To retrieve the job status and host job output, right-click the test script source and 
select the Recover Job Statuses option. 

4. In the Test Log window, expand the events under Event Type to display any 
informational or failure messages that might have been generated by the schedule run. 
If the job was not monitored, an informational message of “Job JobId is left running” is 
displayed.  

5. Right-click on any message and click Properties.  
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The Log Event window is displayed. If the job fails, the Failure Description field may 
provide details on error messages. 

 

6. Use the scroll arrows on the right side of the Log Event window to view the values for 
the other properties of the log events. See Appendix E: Troubleshooting for more 
information about error messages. 

7. A host job output file may exist after a job completes for a schedule run. In the Test 
Script window, right-click the schedule and select the View Host Job Output option to 
view this log.  
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This completes the procedure for running a WSim TM schedule and viewing its output. 

Notes:  

• The same WSim TM schedule under a specific TSO user should not be run in parallel 
because of how the WSim TM schedule is set up.  

• In addition to the Run menu option, the following options are also available from the 
menus that appear when you right-click a source, project, or schedule: 

Edit Login Information. Available when you right-click a test script source, this option 
lets you edit the login parameters of the test script. If you edit these parameters, right-
click Refresh All and then expand the test script source to refresh and reload the 
correct projects and schedules. 

Clear Login Information. Available when you right-click a test script source, this 
option deletes the test script source’s login parameters. Use this option to clear the 
login information before deleting the test script source. Then, to delete the source, 
right-click the source and select Delete. Deleting a test script source is expected after 
clearing login information. If you delete a test script source without clearing the login 
parameters first, and then create a new source in the same directory, the old login 
parameters will be used by the new source, and you may get a warning stating that 
another user is using the directory as a source repository. 

Recover Job Statuses. Available when you right-click a test script source, this option 
displays the status of running jobs, if job monitoring is not specified in the Edit 
Information window. This option returns the status of all jobs and stores the host job 
output in the Logs directory under the test script source directory. 

View Host Job Output. Available when you right-click a test script source, project, or 
schedule, this option displays the host job output logs resulting from schedule runs. All 
logs for the projects and schedules under a test script source are displayed when the 
test script source is highlighted.  

Clear Host Job Output Files. Available when you right-click a test script source, 
project, or schedule, this option deletes the host job output files from the Logs directory 
and puts them into the Recycle Bin.  

View Variables. Available when you right-click a test script source, project, or 
schedule, this option displays the WSim TM variables relative to the selected source, 
project, or schedule. For a test script source, the variables in the VARSINFO member 
are displayed. For a project, the variables in the PROJLIST member of the WSim TM 
TSO user’s data set are displayed. For a schedule, the master and test log data sets 
are displayed. 

View Description. Available when you right-click a project or schedule, this option 
displays the project or schedule description. 
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Editing the JCL skeleton file 

A skeleton JCL file is installed with the WSim Adapters for running WSim TM schedules. The 
skeleton JCL file is the template used for building the job that is submitted to the z/OS system 
for executing a schedule. You can customize the skeleton JCL to include the job accounting 
information required by your z/OS environment and to tailor the job steps to provide the post-
simulation reports needed. This skeleton file is located in the <Rational TestManager 
install>\WSim Adapters\skeleton directory. For more information about the JCL skeleton, see 
Appendix B: Skeleton JCL file and custom JCL script. 

Working with custom JCL scripts 
After installing the WSim Adapters for running custom JCL scripts, you need to register them as 
a new test script type. You can then use them to run custom JCL scripts and see the pass/fail 
results and job output of the run. 

Notes: 

The text in a custom JCL script must be in uppercase. The FTP User Name and a character 
suffix of either A-Z or 0-9 are generally used for the job name. See Appendix B: Skeleton JCL 
file and custom JCL script to see a sample custom JCL script. 

You need an TSO FTP user name and password to use the WSim Adapters for running custom 
JCL scripts. 

Registering the WSim Adapters for running custom JCL scripts 

The first step is to register the WSim Adapters for running custom JCL scripts. You can register 
the WSim Adapters automatically by using the WSim Registration Tool or you can register 
them manually.  

Automatic registration 

1. From the WSim web site, run the WSim registration tool installation program 
(WSimAdaptersRTMRegInstall.exe).  

This places the registration tool, WSimAdaptersRTMRegistrationTool.exe, into the 
WSim Adapters directory in the <Rational TestManager install path >.  

2. Register the WSim Adapters by running the WSimAdaptersRTMRegistrationTool.exe 
program. 

3. Enter a Rational TestManager user name and, if required, its password. 
4. Uncheck the box to specify that you would like to register the JCL Script type and select 

the projects in which you want to run JCL Scripts. 

Manual registration 

1. In Rational TestManager, click Tools->Manage->Test Script Types. 
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2. In the Manage Test Script Types window, click the New button. 

 

3. On the General tab of the New Test Script Type window, name the test script type you 
are creating. For example, you could name the test script type “JCL Scripts”. 

 

4. On the Console Adapter Type tab, click Use a custom console adapter, and enter 
the path to the installed adapter libraries: <Rational TestManager install path>\WSim 
Adapters\ITMJCLCA.dll. 
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5. On the Execution Adapter Type tab, click Use a custom execution adapter, and 
enter the name of the execution adapter: ITMJCLEA. 

 

6. Click OK. 

The new test script type appears in the Manage Test Script Types window. 
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7. In the Manage Test Script Types window, click Close.  

This completes the procedure for registering the adapters for running custom JCL scripts. 

Creating a new test script source 

The next step is to create a local test script source for custom JCL scripts.  

1. If the Test Scripts window is not displayed, click View->Test Scripts.  
2. In the Test Scripts window, right-click the test script type you created when registering 

the adapter (in the example, “JCL Scripts”), and click New Source. 

 

3. On the General tab of the New Test Script Source window, name the source in the 
Name field. For example, you might name it “JCL Scripts Source”. 
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4. On the Connection Data tab, use the Browse button to specify the path where your 
custom JCL scripts are located. If the directory does not exist, you can specify one here 
to create it. For example, you might create the directory C:\JCL Script Source. 

 

Note: This directory must be a unique, local directory that is not used for anything else 
other than a single source. If the directory is used for anything besides a single source, 
run time errors can occur.  

5. Click OK. 
6. Optional: To create paths to other test script sources, repeat this procedure. Remember 

that each test script source MUST have its own unique directory. 

This completes the procedure for creating a new test script source for custom JCL scripts. 

Running a custom JCL file 

The next step is to run a custom JCL file. 

1. If the Test Scripts window is not displayed, click View->Test Scripts.  
2. In the Test Scripts window, expand the source under the test script type you created 

(in the example, “JCL Scripts Source”) by clicking the + symbol next to the source. 
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3. Right-click a script under a test script source and click Run from the pop-up menu. 

 

4. In the Run Test Script window, click OK. 
5. If there is partial or no login information specified at the script or test script source level, 

the Login Information window is displayed . If the Login Information window is not 
displayed and you need to enter login information, right-click the source and select Edit 
Login Information.  
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6. In the Hostname field, enter the name of the host where you want to run the job. 
7. In the TSO FTP User Name and Password fields, enter your host FTP user ID and 

password.  
8. Do one of the following: 

• To display job status while the job is running and to have Rational TestManager 
wait for the job to finish, check the Monitor job execution with Rational 
TestManager box. You can set an execution timeout value in the Job Execution 
Timeout fields. This timeout value specifies how long to monitor the job before it 
ends. The default is no timeout.  

Note: If you specify a job timeout value and the job is cancelled, no host job output 
will be available for viewing. 

• To not have Rational TestManager monitor job status, leave the Monitor job 
execution with Rational TestManager box unchecked. The job will continue to run 
without monitoring.  

9. Test your connection to the host by clicking the Attempt to login to host button.  
10. Click the Save Login Information box to save the login information. If you do not use 

this feature, the login information is used for only one run. Note that a custom JCL script 
uses its own login information, if available; otherwise the login information from the test 
script source is used. 

11. Click OK to submit the job.  

When the run completes, the Test Log window is displayed, and host job output is 
retrieved.  

12. In the Test Log window, expand the events under Event Type to display any 
informational or failure messages that might have been generated by the run. If the job 
was not monitored, an informational message of “Job JobId is left running” is displayed.  

13. Right-click on any message and click Properties.  
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The Log Event window is displayed. 

If the job fails, the Failure Description field may provide more details on error 
messages. 

 

14. Use the scroll arrows on the right side of the Log Event window to view the values for 
the other properties of the log events. See Appendix E: Troubleshooting for more 
information about error messages. 

15. A host job output log may exist after a job completes. In the Test Script window, right-
click the script that was run and select the View Host Job Output option to view the 
output.  
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This completes the procedure for running a custom JCL script and viewing its output. 

Note: 

In addition to the Run menu option, the following options are also available from the menus 
that appears when you right-click a test script source or custom JCL script: 

New Test Script. Available when you right-click a test script source, this option lets you create 
a new custom JCL script file in the test script source directory. All of the JCL must be in 
uppercase. 

Open Test Script. Available when you right-click a custom JCL script, this option lets you edit 
the custom JCL script in Notepad. All the JCL must be in uppercase. 

Edit Login Information. Available when you right-click a test script source and custom JCL 
script, this option lets you edit the test script source or custom JCL script’s login parameters. If 
you edit the login information, right-click the source and click Refresh All from the popup 
menu.  

Clear Login Information. Available when you right-click a test script source or custom JCL 
script, this option deletes the login parameters of the script or test script source. Use this 
option before deleting the test script source itself. Then, delete the source by right-clicking the 
source and selecting Delete. Deletion of the test script source is expected after a Clear Login 
Information action. If you delete a test script source without clearing the login parameters first, 
and then create a new source in the same directory, the old login parameters will be used by 
the new source, and a window stating that another user is using the directory as a source 
repository may appear. 

Recover Job Statuses. Available when you right-click a test script source, this option displays 
the status of running jobs, if job monitoring is not specified in the in the Edit Information 
window. This option returns the status of all jobs and stores the host job output in the Logs 
directory under the test script source directory. 
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View Host Job Output. Available when you right-click a test script source or custom JCL 
script, this option displays the host job output logs resulting from custom JCL script runs. All 
custom JCL script logs under a test script source are displayed when the test script source is 
highlighted.  

Clear Host Job Output Files. Available when you right-click a test script source or custom 
JCL script, this option deletes the host job output files from the Logs directory and puts them 
into the Recycle Bin.  

Delete JCL Script. Available when you right-click a custom JCL script, this option lets you 
delete the JCL script and send it to the Recycle Bin. After deleting a script, right-click its source 
and choose Refresh All.  

Rename JCL Script. Available when you right-click a custom JCL script, this option lets you 
rename the custom JCL script. After renaming a script, right-click it and choose Refresh All.  

Implement Test Case. Available when you right-click a script, this option lets you run a WSim 
TM schedule or custom JCL script. In the Automated Implementation field, click the Select 
button to select a WSim TM schedule or custom JCL script to associate with a test case.  

You cannot view a listing of job logs for schedules by right-clicking a selection for test suites or 
test plans. Instead, right-click the schedule under the test script source and choose the View 
Host Job Output option. Otherwise, use the Recover Job Statuses option by right-clicking 
the test script source to view the log. If the job was monitored, you can also view the logs by 
looking in the Logs directory under the test script source directory. See Rational TestManager 
Help for more information about test suites and creating test plans. 
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Appendix A: Sample WSim TM schedule 
The following is a sample WSim schedule run by the WSim Adapters for Rational 
TestManager. 

* The following network definition was created by WSim/TM 
* at 16:16:49 on 18 Aug 2004 
* 
SCHUSER1  NTWRK HEAD='User 1 schedule', 
                BUFSIZE=2048, 
                COLOR=MULTI, 
                DELAY=F2, 
                DISPLAY=(24,80,32,80), 
                INIT=SEC, 
                ITIME=1, 
                LOGDSPLY=BOTH, 
                LUTYPE=LU2, 
                MLOG=YES, 
*               MSGTRACE=YES, 
                OPTIONS=(CONRATE,DEBUG,MONCMND), 
                RSTATS=YES, 
                STLTRACE=YES, 
                THKTIME=UNLOCK, 
                UTI=100, 
                SEQ=1                   ^^^ DO NOT CHANGE THIS COMMENT ^^^ 
* 
*         Paths 
WTMEND    PATH  WTMEND 
* 
*         TestCase TCLOG1                ^^^ DO NOT CHANGE THIS COMMENT ^^^ 
1         PATH  TCLOG1 
* 
*         Simulated Resources 
USER7A01  VTAMAPPL 
LU01      LU   PATH=(1,WTMEND) 
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Appendix B: Skeleton JCL file and custom JCL script 
The shipped skeleton JCL file looks as follows: 

//!FTPID!!SUFFIX! JOB CLASS=A,MSGCLASS=H,REGION=4M 
//* 
//* Run IBM Workload Simulator (WSim), Loglist, and 
//* Response Time programs from JCL submitted by 
//* WSim Adapters for Rational TestManager using 
//* FTP ID !FTPID! for WSim TSO ID !TSOID! running 
//* WSim Test Manager Project !PROJECT! 
//* Schedule !SCHEDULE!. 
//* 
//JOBLIB   DD  DSN=!WSIMLOAD!,DISP=SHR 
//* WSim 
//WSIM     EXEC PGM=ITPENTER, 
//             PARM='NTWRK=!SCHEDULE!,DMAPPL=!DMAPPL!' 
//SYSPRINT DD  SYSOUT=* 
//INITDD   DD  DSN=!PROJHLQ!.!INITLLQ!,DISP=SHR 
//MSGDD    DD  DSN=!PROJHLQ!.!MSGLLQ!,DISP=SHR 
//LOGDD    DD  DSN=!LOGDS!,DISP=SHR 
//* Loglist 
//LOGLIST  EXEC PGM=ITPLL 
//SYSPRINT DD  SYSOUT=* 
//SYSUT1   DD  DSN=!LOGDS!,DISP=SHR 
//LOGLIST.SYSIN DD * 
CNSLE 
RUN 
END 
/* 
//* Response Time 
//RESPTIME EXEC PGM=ITPRESP 
//SYSPRINT DD  SYSOUT=* 
//SYSUT1   DD  DSN=!LOGDS!,DISP=SHR 
//RESPTIME.SYSIN DD * 
PROCESS ACTUAL 
RUN 
END 
/* 

This job template executes the WSim simulator in the WSIM job step by using the schedule 
already defined on your z/OS system.  After the simulation completes, the LOGLIST job step 
executes the WSim loglist program to report the WSim console records by the CNSLE, RUN, 
and END control statements. The RESPTIME job step executes the WSim response time 
program to report the actual response times the simulated 3270 user(s) experienced, by 
running the PROCESS ACTUAL, RUN, and END control statements. 

There are a number of places in the job template where information from the WSim Adapter’s 
GUI and information retrieved from your z/OS system are plugged in. These are indicated using 
the !keyword! syntax.  For example, the FTP user name being used to submit jobs is 
substituted for !FTPID! in the job submitted to your z/OS system. 

The !keyword! substitution values are defined as follows. 

!DMAPPL! WSim Display Monitor facility VTAM APPL name 
!FTPID! FTP ID being used to submit this job to your z/OS system 
!INITLLQ! WSim INITDD data set low level qualifier  
!LOGDS! Name of last WSim log data set used 
!MLOGDS! Name of Master log data set used if available (for ITPCOMP Compare Utility) 
!MSGLLQ! WSim MSGDD data set low level qualifier 
!PROJECT! WSim TM project name 
!PROJHLQ! WSim TM projects data sets high level qualifier 
!SCHEDULE! WSim TM schedule name 
!SUFFIX! Job name suffix character 
!TLOGDS! Name of Test log data set (for ITPCOMP Compare Utility) 
!TSOID! WSim TSO ID owning the WSim TM schedule 
!WSIMLOAD! WSim load library name 

An example of the JCL sent by the WSim Adapters with the substituted values to your z/OS 
system is as follows: 

//USER7R JOB CLASS=A,MSGCLASS=H,REGION=4M 
//* 
//* Run IBM Workload Simulator (WSim), Loglist, and 
//* Response Time programs from JCL submitted by 
//* WSim Adapters for Rational TestManager using 
//* FTP ID USER7 for WSim TSO ID USER7 running 
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//* WSim Test Manager Project SAMPLEPRJ 
//* Schedule SCHUSER1. 
//* 
//JOBLIB   DD  DSN=WSIM.SITPLOAD,DISP=SHR 
//* WSim 
//WSIM     EXEC PGM=ITPENTER, 
//             PARM='NTWRK=SCHUSER1,DMAPPL=USER7DM' 
//SYSPRINT DD  SYSOUT=* 
//INITDD   DD  DSN=USER7.SAMPPRJ.NTWRKS,DISP=SHR 
//MSGDD    DD  DSN=USER7.SAMPPRJ.MSGTXTS,DISP=SHR 
//LOGDD    DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR 
//* Loglist 
//LOGLIST  EXEC PGM=ITPLL 
//SYSPRINT DD  SYSOUT=* 
//SYSUT1   DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR 
//LOGLIST.SYSIN DD * 
CNSLE 
RUN 
END 
/* 
//* Response Time 
//RESPTIME EXEC PGM=ITPRESP 
//SYSPRINT DD  SYSOUT=* 
//SYSUT1   DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR 
//RESPTIME.SYSIN DD * 
PROCESS ACTUAL 
RUN 
END 
/* 

The submitted skeleton JCL, which is saved as the file SentJCL.log in the WSim Adapters 
directory under the <Rational TestManager install path>\directory for a WSim TM schedule, 
could also be used as a custom JCL script.  For instance, this script could be modified with 
different control statements for the WSim loglist program and run again.  

Another example of a custom JCL script is the following IEFBR14 job to allocate a data set on 
your z/OS system. 

//USER1X  JOB  MSGCLASS=H 
//STEP1   EXEC PGM=IEFBR14            
//MYNEWDS DD   DSN=USER1.MY.NEW.DATASET, 
//             DISP(NEW,CATLG),UNIT=SYSDA,            
//             SPACE=(CYL,(1,1))  

Notes:  

• Alternate project schedules need to be run from the actual TSO user name that created 
the schedule.  

• If any WSim TM schedules contain test cases from another WSim TM project (alternate 
high-level index), add the following line after the //MSGDD    DD statement. 

//         DD  DSN=altdsn.proj.msgtxts,DISP=SHR 

where altdsn.proj.msgtxt is the message deck data set for the alternate project. 

• If you modify the skeleton JCL and get errors as a result of running it, a backup 
skeleton JCL file is provided in case the original becomes corrupted and needs to be 
restored. 
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Appendix C: Host job output example  
Host Job Output example: 

1                     J E S 2  J O B  L O G  --  S Y S T E M  M 0 3 3  --  N O D E  M V S 1 0 8           
0  
 17.10.20 JOB14973 ---- WEDNESDAY, 22 SEP 2004 ---- 
 17.10.20 JOB14973  IRR010I  USERID USER7    IS ASSIGNED TO THIS JOB. 
 17.10.21 JOB14973  ICH70001I USER7    LAST ACCESS AT 17:10:20 ON WEDNESDAY, SEPTEMBER 22, 2004 
 17.10.21 JOB14973  $HASP373 USER7R   STARTED - INIT 1    - CLASS A - SYS M033 
 17.10.21 JOB14973  IEF403I USER7R - STARTED - TIME=17.10.21 
 17.10.21 JOB14973  +ITP016I Workload Simulator (WSim) Version 1 Release 1.0.1, Sept. 3 2004 12:34 
 17.10.22 JOB14973  +ITP003I WSim INITIALIZATION COMPLETE 
 17.10.22 JOB14973  +ITP200I DISPLAY MONITOR FACILITY ACTIVE USING APPL USER7DM 
 17.10.22 JOB14973  +ITP029I INITIALIZATION COMPLETE FOR NETWORK SCHUSER1 
 17.10.22 JOB14973  +ITP006I NETWORK SCHUSER1 STARTED 
 17.10.22 JOB14973 @16 ITP001E 17.10.22.45 WSim USER7R 
 17.10.49 JOB14973  +ITP137I SCHUSER1 LU01    -00001 - WTM: TCLOG1 Finished 
 17.10.49 JOB14973  +ITP137I SCHUSER1 LU01    -00001 - WTMEND: 1 out of 1 finished. 
 17.10.49 JOB14973  +ITP137I SCHUSER1 LU01    -00001 - WTMEND: All scripts run.  Issuing ZEND. 
 17.10.49 JOB14973  +ITP002I SCHUSER1 LU01    -00001 - ZEND 
 17.10.49 JOB14973  +ITP201I DISPLAY MONITOR FACILITY IS CLOSED DOWN 
 17.10.49 JOB14973  +ITP079I WSim IS CLOSED DOWN 
 17.10.49 JOB14973      USER7R      WSIM        ITPENTER    0000 
 17.10.50 JOB14973      USER7R      LOGLIST     ITPLL       0000 
 17.10.50 JOB14973      USER7R      RESPTIME    ITPRESP     0000 
 
 17.10.50 JOB14973  IEF404I USER7R - ENDED - TIME=17.10.50 
 17.10.50 JOB14973  $HASP395 USER7R   ENDED 
0------ JES2 JOB STATISTICS ------                                                                                                    
-  22 SEP 2004 JOB EXECUTION DATE                                                                                                     
-           35 CARDS READ                                                                                                             
-          212 SYSOUT PRINT RECORDS                                                                                                   
-            0 SYSOUT PUNCH RECORDS                                                                                                   
-           15 SYSOUT SPOOL KBYTES                                                                                                    
-         0.48 MINUTES EXECUTION TIME                                                                                                 
 !! END OF JES SPOOL FILE !! 
        1 //USER7R JOB CLASS=A,MSGCLASS=H,REGION=4M                               JOB14973 
          //*                                                                              
          //* Run IBM Workload Simulator (WSim), Loglist, and                              
          //* Response Time programs from JCL submitted by                                 
          //* WSim Adapters for Rational TestManager using                                 
          //* FTP ID USER7 for WSim TSO ID USER7 running                                   
          //* WSim Test Manager Project SAMPLEPRJ                                          
          //* Schedule SCHUSER1.                                                           
          //*                                                                              
        2 //JOBLIB   DD  DSN=WSIM.SITPLOAD,DISP=SHR                                     
          //* WSim                                                                         
        3 //WSIM     EXEC PGM=ITPENTER,                                                    
          //             PARM='NTWRK=SCHUSER1,DMAPPL=USER7DM'                              
        4 //SYSPRINT DD  SYSOUT=*                                                          
        5 //INITDD   DD  DSN=USER7.SAMPPRJ.NTWRKS,DISP=SHR                                 
        6 //MSGDD    DD  DSN=USER7.SAMPPRJ.MSGTXTS,DISP=SHR                                
        7 //LOGDD    DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR                          
          //* Loglist                                                                      
        8 //LOGLIST  EXEC PGM=ITPLL                                                        
        9 //SYSPRINT DD  SYSOUT=*                                                          
       10 //SYSUT1   DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR                          
       11 //LOGLIST.SYSIN DD *                                                             
          //* Response Time                                                                
       12 //RESPTIME EXEC PGM=ITPRESP                                                      
       13 //SYSPRINT DD  SYSOUT=*                                                          
       14 //SYSUT1   DD  DSN=USER7.SAMPPRJ.MLOG.SCHUSER1,DISP=SHR                          
       15 //RESPTIME.SYSIN DD *                                                            
 !! END OF JES SPOOL FILE !! 
 ICH70001I USER7    LAST ACCESS AT 17:10:20 ON WEDNESDAY, SEPTEMBER 22, 2004 
 IEF236I ALLOC. FOR USER7R WSIM 
 IEF237I 3396 ALLOCATED TO JOBLIB 
 IEF237I JES2 ALLOCATED TO SYSPRINT 
 IEF237I 04FD ALLOCATED TO INITDD 
 IEF237I 04FD ALLOCATED TO MSGDD 
 IEF237I 04FF ALLOCATED TO LOGDD 
 IEF142I USER7R WSIM - STEP WAS EXECUTED - COND CODE 0000 
 IEF285I   WSIM.SITPLOAD                             PASSED         
 IEF285I   VOL SER NOS= LSSWK7.                             
 IEF285I   USER7.USER7R.JOB14973.D0000103.?             SYSOUT         
 IEF285I   USER7.SAMPPRJ.NTWRKS                         KEPT           
 IEF285I   VOL SER NOS= CPDLB2.                             
 IEF285I   USER7.SAMPPRJ.MSGTXTS                        KEPT           
 IEF285I   VOL SER NOS= CPDLB2.                             
 IEF285I   USER7.SAMPPRJ.MLOG.SCHUSER1                  KEPT           
 IEF285I   VOL SER NOS= CPDLB0.                             
 IEF373I STEP/WSIM    /START 2004266.1710 
 IEF374I STEP/WSIM    /STOP  2004266.1710 CPU    0MIN 00.05SEC SRB    0MIN 00.02SEC VIRT  1412K SYS   308K EXT     344K SYS   
11684K 
 IEF236I ALLOC. FOR USER7R LOGLIST 
 IEF237I 3396 ALLOCATED TO JOBLIB 
 IEF237I JES2 ALLOCATED TO SYSPRINT 
 IEF237I 04FF ALLOCATED TO SYSUT1 
 IEF237I JES2 ALLOCATED TO SYSIN 
 IEF142I USER7R LOGLIST - STEP WAS EXECUTED - COND CODE 0000 
 IEF285I   WSIM.SITPLOAD                             PASSED         
 IEF285I   VOL SER NOS= LSSWK7.                             
 IEF285I   USER7.USER7R.JOB14973.D0000104.?             SYSOUT         
 IEF285I   USER7.SAMPPRJ.MLOG.SCHUSER1                  KEPT           
 IEF285I   VOL SER NOS= CPDLB0.                             
 IEF285I   USER7.USER7R.JOB14973.D0000101.?             SYSIN          
 IEF373I STEP/LOGLIST /START 2004266.1710 
 IEF374I STEP/LOGLIST /STOP  2004266.1710 CPU    0MIN 00.01SEC SRB    0MIN 00.00SEC VIRT   224K SYS   264K EXT       4K SYS   
11548K 
 IEF236I ALLOC. FOR USER7R RESPTIME 
 IEF237I 3396 ALLOCATED TO JOBLIB 
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 IEF237I JES2 ALLOCATED TO SYSPRINT 
 IEF237I 04FF ALLOCATED TO SYSUT1 
 IEF237I JES2 ALLOCATED TO SYSIN 
 IEF142I USER7R RESPTIME - STEP WAS EXECUTED - COND CODE 0000 
 IEF285I   USER7.USER7R.JOB14973.D0000105.?             SYSOUT         
 IEF285I   USER7.SAMPPRJ.MLOG.SCHUSER1                  KEPT           
 IEF285I   VOL SER NOS= CPDLB0.                             
 IEF285I   USER7.USER7R.JOB14973.D0000102.?             SYSIN          
 IEF373I STEP/RESPTIME/START 2004266.1710 
 IEF374I STEP/RESPTIME/STOP  2004266.1710 CPU    0MIN 00.01SEC SRB    0MIN 00.00SEC VIRT   152K SYS   264K EXT       8K SYS   
11552K 
 IEF285I   WSIM.SITPLOAD                             KEPT           
 IEF285I   VOL SER NOS= LSSWK7.                             
 IEF375I  JOB/USER7R  /START 2004266.1710 
 IEF376I  JOB/USER7R  /STOP  2004266.1710 CPU    0MIN 00.07SEC SRB    0MIN 00.02SEC 
 !! END OF JES SPOOL FILE !! 
1WSim 1.1.0.1 PRINTER OUTPUT                                                TIME 17.10.49, SEPTEMBER 22, 2004   PAGE      1           
0                                                     END OF RUN REPORT                                                               
0         NETWORK  SCHUSER1                           User 1 schedule                                           NTWRKUTI     100      
0                           STATUS    MESSAGES                    RESPONSES                                                           
                                  RECEIVED   SENT         RECEIVED          SENT                                                      
                                                         DEF     EXC     DEF     EXC                                                  
0VTAMAPPL USER7A01                                                                                                                    
   LU       LU01-1                     27      11          1       0      22       0                                                  
0  VTAMAPPL TOTALS                     27                  1              22                                                          
                                               11                  0               0                                                  
-  CUMULATIVE TOTALS                   27                  1              22                                                          
                                               11                  0               0                                                  
 !! END OF JES SPOOL FILE !! 
1WSim LOGLIST OUTPUT                                                        TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      1           
0CNSLE                                                                                                                                
 RUN                                                                                                                                  
1WSim LOGLIST OUTPUT                                                        TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      2           
 RUN  TIME 17.10.22, SEPTEMBER 22, 2004  VERSION  1  RELEASE  1.0.1                                                                   
                                                                                                                                      
 NETWORK   APPCLU/TCPIP/VTAMAPPL   DEV/LU/TP        START    STOP     READY  RECORD   HEADER      DATA  TYPE  MESSAGE   USER 
SEQUENCE 
  NAME             NAME              NAME           TIME     TIME     TIME    TYPE    FLAGS       LENG          DECK    DATA  
NUMBER  
0                                                 17102227 0104266  11010000  CNSL  0800 000000     69                                
0  Workload Simulator (WSim) Version 1 Release 1.0.1, Sept. 3 2004 12:34                                                              
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17102244 0104266  11010000  CNSL  0800 000000     52                                
0  ITP029I INITIALIZATION COMPLETE FOR NETWORK SCHUSER1                                                                               
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17102244 0104266  11010000  CNSL  0800 000000     32                                
0  ITP006I NETWORK SCHUSER1 STARTED                                                                                                   
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17104990 0104266  11010000  CNSL  0800 000000     54                                
0  ITP137I SCHUSER1 LU01    -00001 - WTM: TCLOG1 Finished                                                                             
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17104990 0104266  11010000  CNSL  0800 000000     62                                
0  ITP137I SCHUSER1 LU01    -00001 - WTMEND: 1 out of 1 finished.                                                                     
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17104990 0104266  11010000  CNSL  0800 000000     73                                
0  ITP137I SCHUSER1 LU01    -00001 - WTMEND: All scripts run.  Issuing ZEND.                                                          
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17104990 0104266  11010000  CNSL  0800 008000     38                                
0  ITP002I SCHUSER1 LU01    -00001 - ZEND                                                                                             
0-------------------------------------------------------------------------------------------------------------------------------
----- 
0                                                 17104990 0104266  11010000  CNSL  0800 000000     47                                
0  ITP201I DISPLAY MONITOR FACILITY IS CLOSED DOWN                                                                                    
1WSim LOGLIST OUTPUT                                                        TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      3           
0END                                                                                                                                  
 !! END OF JES SPOOL FILE !! 
1WSim RESPONSE TIME ANALYSIS                                                TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      1           
0PROCESS ACTUAL                                                                                                                       
 RUN                                                                                                                                  
1WSim RESPONSE TIME ANALYSIS                                                TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      2           
 RUN  TIME 17.10.22, SEPTEMBER 22, 2004  VERSION  1  RELEASE  1.0.1                                                                   
0--------------------------------------------------------------------------------------------------------------------------           
 TERMINAL REPORT    NETWORK  ALL NETWORKS      PROCESS  ACTUAL      TIME LIMITS ALL                                                   
                    VTAMAPPL USER7A01          EXIT                 START TIME  171024                                                
                    TERMINAL LU01-1            TERMTYPE LU2         END TIME    171047                                                
 --------------------------------------------------------------------------------------------------------------------------           
-RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT           
0         0.00        2            0.01        1            0.02        2            0.08        1            0.09        1           
          0.19        1            0.86        1            1.15        1            2.00        1                                    
-MEAN   RESPONSE             0.40    MESSAGES SENT            11    NUMBER OF RESPONSES         11                                    
 MEDIAN RESPONSE             0.08       AVERAGE LENGTH        36                                                                      
 MODE   RESPONSE               --                                   RESPONSES DISCARDED          0                                    
 LOW    RESPONSE             0.00    MESSAGES RECEIVED        24    VARIANCE                0.4337                                    
 HIGH   RESPONSE             2.00       AVERAGE LENGTH       445    95 PERCENT CI               --                                    
 AVERAGE QUEUE TIME          0.00                                                                                                     
-PERCENTILE    RESPONSE TIME        AVERAGE                                                                                           
0    90                 1.15           0.24                                                                                           
1WSim RESPONSE TIME ANALYSIS                                                TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      3           
 RUN  TIME 17.10.22, SEPTEMBER 22, 2004  VERSION  1  RELEASE  1.0.1                                                                   
0--------------------------------------------------------------------------------------------------------------------------           
 TERMGRP  REPORT    NETWORK  ALL NETWORKS      PROCESS  ACTUAL      TIME LIMITS ALL                                                   
                    VTAMAPPL USER7A01          EXIT                 START TIME  171024                                                
                                               TERMTYPE             END TIME    171047                                                
 --------------------------------------------------------------------------------------------------------------------------           
-RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT           
0         0.00        2            0.01        1            0.02        2            0.08        1            0.09        1           
          0.19        1            0.86        1            1.15        1            2.00        1                                    
-MEAN   RESPONSE             0.40    MESSAGES SENT            11    NUMBER OF RESPONSES         11                                    
 MEDIAN RESPONSE             0.08       AVERAGE LENGTH        36                                                                      
 MODE   RESPONSE               --                                   RESPONSES DISCARDED          0                                    
 LOW    RESPONSE             0.00    MESSAGES RECEIVED        24    VARIANCE                0.4337                                    
 HIGH   RESPONSE             2.00       AVERAGE LENGTH       445    95 PERCENT CI               --                                    
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 AVERAGE QUEUE TIME          0.00                                                                                                     
-PERCENTILE    RESPONSE TIME        AVERAGE                                                                                           
0    90                 1.15           0.24                                                                                           
1WSim RESPONSE TIME ANALYSIS                                                TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      4           
 RUN  TIME 17.10.22, SEPTEMBER 22, 2004  VERSION  1  RELEASE  1.0.1                                                                   
0--------------------------------------------------------------------------------------------------------------------------           
 SUMMARY  REPORT    NETWORK  ALL NETWORKS      PROCESS  ACTUAL      TIME LIMITS ALL                                                   
                                               EXIT                 START TIME  171024                                                
                                               TERMTYPE             END TIME    171047                                                
 --------------------------------------------------------------------------------------------------------------------------           
-RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT   RESPONSE TIME    COUNT           
0         0.00        2            0.01        1            0.02        2            0.08        1            0.09        1           
          0.19        1            0.86        1            1.15        1            2.00        1                                    
-MEAN   RESPONSE             0.40    MESSAGES SENT            11    NUMBER OF RESPONSES         11                                    
 MEDIAN RESPONSE             0.08       AVERAGE LENGTH        36                                                                      
 MODE   RESPONSE               --                                   RESPONSES DISCARDED          0                                    
 LOW    RESPONSE             0.00    MESSAGES RECEIVED        24    VARIANCE                0.4337                                    
 HIGH   RESPONSE             2.00       AVERAGE LENGTH       445    95 PERCENT CI               --                                    
 AVERAGE QUEUE TIME          0.00                                                                                                     
-PERCENTILE    RESPONSE TIME        AVERAGE                                                                                           
0    90                 1.15           0.24                                                                                           
1WSim RESPONSE TIME ANALYSIS                                                TIME 17.10.50, SEPTEMBER 22, 2004   PAGE      5           
 RUN  TIME 17.10.22, SEPTEMBER 22, 2004  VERSION  1  RELEASE  1.0.1                                                                   
0END                                                                                                                                  
 !! END OF JES SPOOL FILE !! 
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Appendix D: Debugging 
The following files can be used for debugging: 

The most recently-sent JCL file for the WSim TM schedule is saved in the file <Rational 
TestManager install path>\WSim Adapters\SentJCL.log.  

The following logs exist for both the WSim schedules and custom JCL scripts and are in the 
Logs directory under the <test source script> directory.  

FTP.log contains the information from sending the information for the WSim TM schedule or 
custom JCL run.  

MSG.log contains the information displayed in the window from the job run.  

hjorecover.log contains information from the retrieval of the host job output file. 

The following log is only for WSim TM schedules and exists in the HOST_DATA directory 
under the <test script source> directory. 

psretrieve.log contains information from retrieval of the WSim TM project and schedule.  
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Appendix E: Troubleshooting  
This appendix lists some of the possible errors you may encounter when running WSim TM 
schedules and custom JCL scripts. Job return codes are checked. For a WSim TM schedule 
run, there is a search for the string “WTMEND: All scripts run” to indicate a successful run. 
User actions follow the error descriptions. 

Message: The FTP username or password is incorrect 
Explanation: You have bad login information. 
Action: Correct the login information. 
 
Message: Invalid hostname  
Explanation: The given hostname is not a valid hostname.   
Action: Correct the hostname. 
 
Message: Unable to connect to the requested host     
Explanation: Hostname is unknown.  
Action: Check and correct the hostname. 
 
Message: There is no FTP server running on the host  
Explanation: The host is not accepting FTP connections. 
Action: Check and correct the hostname or install/start the 

appropriate FTP server with JES on the host due to 
timeout. 

 
Message: The ftp command has been canceled due to a timeout. 
Explanation: The ftp communication has timed out. 
Action: If the job was started on the host machine, Host Job 

Output can still be downloaded using the Recover Job 
Statuses selection. Otherwise, run the test again. If 
problem persists, run tests serially instead of in 
parallel. 

 
Message: FTP communication has timed out  
Explanation: The ftp communication has timed out. 
Action: If the job was started on the host machine, the Host 

Job Output can still be downloaded by using the 
Recover Job Statuses option. Otherwise, try running 
the test again.  If the problem persists, run the 
tests serially instead of in parallel. 

 
Message: JES is not implemented on the host machine   
Explanation: JES is not installed.  
Action: Install JES. 
 
Message: Unable to open file filename for reading. 
Explanation: The WSim Adapter could not read from filename. 
Action: Make sure filename exists and that you have read 

access. 
 
Message: File filename is an empty file  
Explanation: The file filename is an empty file.  
Action: Check the submitted JCL or skeleton file.  It should 

not be blank. 
 
Message: An unknown error number num has occurred in procedure 
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Explanation: An unexpected system error number num occurred during 
procedure. A system provided error message (if one 
exists) is also displayed. 

Action: If the problem persists, contact your system 
administrator. 

 
Message: Could not locate job JobId.  FTP user might not have 

access to job. 
Explanation: Job JobId was started by JES, but the job cannot be 

found on the host.  Either the FTP user who submitted 
the job does not have access to view the job, or the 
job was canceled. 

Action: If submitting a custom JCL script, make sure the 
JOBNAME is the FTP user ID with an additional 
character of 0-9 or A-Z.  Otherwise, check with the 
system administrator to make sure you have permission 
to view submitted JES jobs, and that they were not 
canceled. 

 
Message: Unable to open file filename for writing 
Explanation: The WSim Adapter tried to write to filename but could 

not. 
Action: Make sure the directory containing filename and 

filename are not read only.  If you have permission to 
write to filename, reboot to remove any locks other 
processes might have on filename. 

 
Message: num of total job steps returned non-zero condition 

codes 
Explanation: Some job steps returned non-zero condition codes, 

indicating an error during execution on the host 
machine. 

Action: Look at the Host Job Output for more details. 
 
Message: "WTMEND: All scripts run" not found in schedule 

output. 
Explanation: The WSim Adapter expects to find this message to 

indicate the successful execution of the WSim TM 
schedule. 

Action: Look at the Host Job Output for more details. 
 
Message: Job step ended abnormally. 
Explanation: A job step ended abnormally (with an ABEND), 

indicating an error during execution on the host 
machine. 

Action: Look at the Host Job Output for more details. 

Below is a list of informational messages given through Rational TestManager: 

Message: Job JobId left running 
Explanation: The job, JobId, was left running on the host machine. 
Action: The Host Job Output should be downloaded later with 

the Recover Job Statuses selection. 
 
Message: Host Job Output has been saved to filename 
Explanation: The Host Job Output is saved on the local computer at 

the specified location. 
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Action: View the Host Job Output in the location specified, if 
needed. 

The WSim Adapters have limited control over the testing environment provided by the Rational 
TestManager. The following warnings/errors may be presented by Rational TestManager but 
should not impact the operation of the WSim Adapters.  

General restrictions: 

• Remote Rational TestManagers are not supported. 
• Projects being shared from a database through multiple Rational TestManagers are not 

supported. 

Test script source restrictions and errors: 

• Do not use the same directory for two or more test scripts. This could cause possible run 
time errors.  

• The following message may appear when one user is using the same local directory for a 
script source as another Rational TestManager user. 

“Another user is using <RTM test cases> as a source repository. It is highly recommended 
that a directory only be used as one source repository. Unexpected behavior with login 
information can occur if multiple users access the same repository.” 

You can disable the check for this by deleting registry value 
HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Rational Test\WSim 
Adapters\_SAMEUSRMSG_ or by changing its value to “0”.  

Test suite restrictions and errors: 

• You could get the following error message when selecting a new test script by using the 
Function Suite Wizard.  

“Application Error: An unknown error was encountered selecting a type from the 
AutoSchedWizard2 property page.” 

You can ignore this message. This is a known problem with Rational TestManager. 

• You could get the datastore error #203 when right-clicking Properties on a test script  
because of a test case not being selected for the implementation.  

• Choosing to monitor resources under Resource Monitoring may cause a hang. If there is a 
hang, select File -> Run Test Suite again for the same suite. Uncheck the Monitor 
resources box. The test suite should run. 

• If you are running a test case in a test suite or plan that does not have a schedule selected 
in the Automatic Implementation section under the Implementation tab, the following 
message may occur: 
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ERROR! Test script source not configured properly 

Bring up the Properties window and select the Implementation tab. Click the Select 
button, select a project, and then select a schedule based on the test script source. 

• If you try to set a test script as the implementation for a test case but you have not 
successfully loaded a project list for the source, the following message appears: 

No files found for the given source. Please try reloading the projects and schedules from the 
source in the test script view.  

• If the login information for a WSim TM schedule has changed and this schedule is being set 
as the implementation for a test case, the following message appears: 

You have changed your account information for this source since the last refresh and/or 
reload of the projects and schedules. You must refresh your test script view and reload the 
project and schedule information before running a schedule. 

Would you like to reload the schedules?   

Choose Yes or No. 

• If you change the login information for a WSim TM schedule and then try to run it, the 
following error message appears: 

You have changed your account information for this source since the last refresh and/or 
reload of the projects and schedules. You must refresh your test script view and reload the 
project and schedule information before running or selecting a schedule. 

FTP errors and situations: 

• If there is a hang in when retrieving projects or schedules, check the log to see where the 
hang occurred. There is a timeout value of 50 seconds for FTP connection and two minutes 
for retrieval. 

If there is a timeout, you must issue a Refresh All and expand the test script source to get 
the latest projects and schedules. 

• If there is a hang in the Recover Job Statuses action, check the log to see locate the hang. 
There are three timeouts of two minutes each for a total of six minutes. 

If there is a timeout, reissue the Recover Job Statuses action. 

• The error message “Host directory structure is not set up correctly” appears when there is 
no VARSINFO member found for the user ID. Check to make sure a WSim TM project and 
schedules have been created. 

• The Windows error message “PROJLIST member doesn’t exist, can’t FTP the member” 
could be caused by a member in use, even though the error message is not correct.  

• If PROJLIST does not contain the projects, the following message appears:  
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No projects exist in account  

Ensure that a WSim TM project and schedules have been created. 

• A right-click on a project does not return any information. 
• Submitting a job may cause a hang. There is a timeout value of 50 seconds. 

Login Information errors: 

• Before running a test script, provide all the login information needed for a run. Otherwise, 
users who submit multiple test scripts within a suite may have the login window waiting for 
information. This causes a delay in the execution of the test script. 

• Running a schedule after changing the login information without a refresh may cause the 
following message: “Fatal compile error, run terminated” to appear in the Messages from 
running suite window. The user must refresh the projects and schedules. 

Schedule run errors and restrictions:  

• The log data set may be missing from a schedule and cause the submitted job to have a 
JCL error. This could occur for WSim TM schedules created prior to WSim Version 1 
Release 1.0.1 that were never run. This could also occur for schedules that were created 
outside WSim TM and placed into the schedules data set.     

• If RTM 6.00 is installed on Windows 2000, the Monitor->Stop Test Run selection actions 
do not work. If Rational TestManager 6.12 is installed on Windows 2000 or XP, the abort 
action of the Monitor->Stop Test Run cancels the job. 

• If a job is terminated because of a stop run action or because a timeout is reached, check 
the status of the LUs in the WSim schedule to ensure they are not in a logged on state or 
any other state.  

• If the job does not start or complete, check the job on MVS. The job may need to be ended 
or cancelled. 

• If the job is still in active state and Rational TestManager is closed, the job status window 
may still be active. Either end the job on MVS or kill the rtstsee.exe process.  

• Various error situations could occur that would leave the job running. Check the job on the 
host system if the job appears to be running too long. 

• Do not run a test plan after a test case or test suite has been started. An abend occurs. 
This is a known RTM problem. 

Migration issues:  

• If no loglist data set has yet been created , a submitted job will have a JCL error due to an 
invalid loglist data set of null. The assumption is that the schedule has been run already. 
Otherwise, run the schedule from WSim TM and then refresh the projects and schedules 
from the WSim Adapters and run the schedule again.  

• The WSim Adapters use the accent mark (`) for parsing strings. WSim project names 
should not contain this mark. 
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